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CPG2 COURSE ARCHITECT TUTORIAL 

MENU tutorial by Dave Craven 

Welcome to the Course Editor for Customplay Golf 2, (CPG2). Here you will find some tips for understanding the 
basics and getting started in creating great 3D golf courses. This tutorial will not show every aspect of the Editor as 
there are sometimes alternative ways to do things but understanding the basics is essential to making good courses. 

So let’s get right to it! Clicking the CREATE button from the main menu of the game takes you to the main Course 
Architect screen, below. As you can see there are various menus across the bottom of the screen and here we will 
look at them in turn and see what each option or sub menu does. If you have printed this out you may want to have 
the Architect open on your screen as you read the manual so you can directly relate the text on the page to the visual 
on the screen. 

The ‘FILE’ Menu 

 

QUIT: Quits the editor and goes back to the main Game menu. 

RESET: Returns the Editor back to the basic introduction screen, (as above), and wipes any changes that you may 
have put onto the land plot. This might typically be used if you are 5 minutes into a design and decide that you just 
want to ‘wipe the slate clean’ and start again. 

PLAY: If you are in the middle of designing and wish to see how the current hole, or course, that you are designing 
plays then this is the button to press. Making a ‘SAVE’ before pressing ‘PLAY’ is recommended. 

TEST: Allows you to walk around the land plot, (from a predefined point as set by the user), while in the Editor. This 
option is very good for looking at things like lake banks, bunkers and added land shapes as it gives you a players 
perspective of anywhere on the land plot that you choose. Making a ‘SAVE’ before pressing ‘TEST’ is recommended. 

PUBLISH: For the course you have designed to be played in the Game it must be published. A published course file 
cannot have any more alterations made to it and is the only way that the course can be played in the Game. Secondly, 
playing and testing the course in the Editor means you are looking at a low resolution version of the course. To really 
see the course at its best you would need to publish a beta version of the course to play in the Game. As you can 
literally end up with hundreds of saves of the same course during its build process, I would recommend adding the 
word beta to the Course save name, i.e. ‘My Golf Course Beta 001’. (Publishing a ‘course file’ in the Editor does not 
alter the ‘course file’ that you choose to publish. The published course is a separate, new file). 

IMPORT: Used for importing courses from the CPG1 game ready for converting to CPG2. An imported course is not 
perfect and would need tweaking before publishing! (NOTE: If you did not release a course for CPG1 then this button 
shouldn’t concern you. 

SAVE AND ZIP: Saves and zips the course that you currently have open in the Editor. This is useful for sharing of 
projects with 2 or more fellow golf course designers. 

SAVE: Saves the course that you are currently working on. Pressing SAVE will take you to a screen that will ask you 
to name the file you are saving. I would suggest using the Golf Course name plus 3 digits, i.e. ‘My Golf Course 001’. 

LOAD: Shows a screen where you can pick an unpublished course to load into the Architect. 
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The ‘EDIT’ Menu 

 

TEE NAMES: Allows you to assign names to tees. 

LOGO: Allows the user to add a texture, (Logo), to the course that will show up in special circumstances, like flybys. 

UNLOCK ALL: Unlocks any and all shapes on the course that you have previously locked. 

LOCK ALL: Locks all shapes on the course to prevent any accidental editing of them. 

DELETE ALL OBJECTS: Deletes all the objects, (buildings, fences, ball washers, benches, etc), that are currently 
placed on the course. 

DELETE ALL TREES: Deletes all the trees that are currently planted on the course. 

DELETE ALL BLENDS: Deletes all blends that have been put on the course by the user. 

BLEND ALL: Places a blend around all shapes on the course. Usually only used when the course is finished and just 
before publishing. But if used they can be removed with the ‘DELETE ALL BLENDS’ option above. 

EDIT DETAILS: Allows you to name the course and add some detailed info about it that can be viewed in the Course 
Selection Screen, in the Game, when selecting courses to be played. 

REDO: Allows you to ‘add back’ something you have just ‘UNDONE’. 

UNDO: Will undo the user’s previous action. Example: You click on a point on a fairway to move it a fraction and 
accidentally move the whole fairway. Undo will snap the whole fairway back to the original point on the plot. 

The ‘LAYERS’ Menu 

 

SKY: Lets you see the course from above the clouds. Left clicking anywhere on the sky will place the sun in that 
position above your course. Right clicking on the screen brings up a sub menu. PANO: Lets you select which 
panorama you want to assign to your course and while there you can determine its height in relation to the course and 
also rotate it so you can line up specific points of a panorama in view from certain holes. (See picture below).  
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NORTH: Lets you determine which way north faces in relation to the course. AMBIENT SOUNDS: Allows you to select 
WAV sound file that will be heard while playing the course. There are three stock bird loop WAV files that are selected 
by default, but you can insert custom sounds if desired. There are also sliders to select the minimum and maximum 
amount of times the sounds will be played. (NOTE: Any window that opens in the main screen can be moved and 
placed on the screen by left click and dragging the header bar). 

HEIGHT: Allows you to edit the terrain in a 3D environment such as shaping hills, bunkers, slopes, lakes etc. You may 
also place objects on the terrain whilst in the Height Editor screen and this is preferable to doing it in the Surface 
Editor screen as once the ground is uneven through modelling the land plot you can only see the shape of the land 
you are planting an object on in the Height Editor screen, i.e. Buildings often need to be on flat land. 

SURFACE: The default opening screen of the Course Architect allows the user to place shapes and objects onto the 
surface of a course. Some examples of shapes are Tees, Greens, Fairways, Fringes, Bunkers, Cart Paths and Flower 
Beds. In this screen the user can also assign textures, sounds and templates to shapes. 

The ‘TOOLS’ Menu 

 

 

GROUP TEMPLATE CHANGE: allows you to replace all instances of one or more existing templates used by shapes 
on the plot with another template of your choice. This option is a godsend for CPG1 conversions but can also save a 
lot of time in regular CPG2 designs. 

SCALE ALL: Allows you to rescale all the shapes on the plot including the plot itself at one time as a group. 

DXF: Allows a user to import shape and elevation data from an AutoCAD type DXF file composed of separate shape 
and/or mesh layers for use in creating real courses. 
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BLUEPRINT TOOL: This is used for overlaying the land plot with satellite pictures of real golf courses to help quickly 
layout the golf course, in a manner similar to tracing. The Blueprint menu has settings to adjust the size of the overlaid 
picture and you can also set the opacity of the picture to a level that suits you personally. 

 

TAPE MEASURE: Can be used for measuring shot distances, lengths of holes, widths of greens etc. (You will see 
this later when making a basic hole). Once turned on just left click on the screen and drag the mouse to the desired 
point to see the measurement. The tape measure can be moved around the screen by clicking on the measure 
between the start and end points and dragging. 

GRID: Used for overlaying a grid on the surface land plot. The grid size is scalable and is useful when making a 
course to get an idea of how big your shapes are, e.g. if you make the grid with 50yd spacing you can get a rough 
idea of how long/wide your holes are without using the measure tool. 

 

The ‘VIEW’ Menu 

 

The options in this menu are all selectable as either ON, (ticked box), or OFF, (empty box). If an option is ON you can 
see it on the course. If an option is OFF, that option is hidden from view. 

HOLE NUMBERS: Turns ON or OFF the hole numbers on the course. 
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SHOW WATER: Turns ON or OFF the Water on the course. 

SHOW TREES: Turns ON or OFF the trees on the course. You will use this more than any other option. Once a 
course has been planted then any further detail work on the terrain will be hampered by having trees turned on as 
they can obscure your view, are easy to accidentally click on and then move and drag etc. Common places that they 
would be in the way would be near bunkers and lake banks. (They do not need to be turned back on to be viewed in 
the Editor whilst playing the course). 

SHOW OBJECTS: Turns ON or OFF the objects, (like buildings, tee boxes, benches, etc), on the course. Like the 
tree option above, objects can also hinder design work after they have been placed on the course. As above, just hide 
them from view. (They do not need to be turned back on to be viewed in the Editor whilst playing the course). 

HOT KEYS: Turns ON or OFF the HOT KEY menu.  

RESET CAMERA: Resets the camera view to the default location zoomed way out directly above the course when 
you open Create mode. 

The ‘OPTIONS’ Menu 

The final menu is the ‘OPTIONS’ Menu but at the time of writing the functions for this menu have yet to be 
incorporated into the game but will be addressed in future updates. 
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CPG2 COURSE ARCHITECT TUTORIAL 

Surface Layer tutorial by Brian Silvernail 

The ‘SURFACE LAYER’ Add Menu 

The surface layer is where the core elements of your course are created. Holes are drawn on the surface layer and 
objects can also be placed on this layer as well. 

Right clicking on the land plot brings up the ADD, EDIT or VIEW menu 

 

Add Object: Brings up a file menu where you can then select the type of 3D object file you would like to add to your 
course. This subject is covered in more detail in a separate tutorial. 

Add 2D Object: Brings up a file menu where you can then select the type of 2D object file you would like to add to 
your course. This subject is covered in more detail in a separate tutorial. 

Add Particle System: Brings up a file menu where you can then select a particle system to add to your course. This 
would allow you to place mist on a lake, or smoke coming out of a volcano for instance 

 

 

Set Test Start Position: This allows you to choose a starting point for when you enter course test mode. It will show 
as a white sphere on the land plot and you can click and drag it to reposition the starting point. It is very handy to 
reposition this as you work on specific holes of your course design. You could also move it by left click/dragging it to 
the new desired location. 
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Add Shot Marker: This is the point the golfer aims at while on the tee and appears on the surface layer as a large 
white sphere. Only one shot target per hole is required. The Shot Marker can be repositioned at any time. When you 
choose ‘Add Shot Marker’, CPG2 will ask you to assign the Shot Marker to a specific hole. 

 

 

 

Add Pin: This allows you to add pin positions to your course’s greens. When you choose ‘Add Pin’, CPG2 will ask you 
to assign the pin to a specific hole. Up to five pin positions can be placed on each green. 
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The ‘SURFACE LAYER’ Edit Menu 

 

The land plot can be adjusted by right-clicking on it and choosing the ‘Edit’ menu. 

 

 

Rotate: This brings up a slider that allows you to rotate the land plot. 

Scale: This brings up a slider that allows you scale the land plot. 

Lock: This locks the shape of the land plot so that it can’t be edited. Once locked, it can be unlocked through the ‘Edit’ 
menu. 
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Edit Template: This allows you to create a template for your course. Templates are used to store common settings 
for your course terrain (fairway, tees, greens, bunkers, etc.)  

 

 

 

Rotate and Scale Texture: This allows you to enlarge or reduce the scale of the texture you have chosen for the land 
plot. You can also rotate the texture as well. (NOTE: This could help you line up two similar textures that are side by 
side on the plot). 
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Grass: This allows you to add grass effects to the land plot. You can choose up to three different colors for the grass 
effect, as well as change the grass height and density. The ‘Enable’ check box in the upper left corner must be 
selected for the effect to be activated. 

 

Changing the shape of the land plot 

 

The shape of the land plot can be adjusted by clicking and dragging on any of the four corner control points. 
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If you place the pointer along one of the four edges of the land plot, it will highlight the edge as shown above. Right-
clicking and choosing the ‘Edit’ menu will bring up a series of options. 

 

 

 

Make Curve Section: This changes the section between two 'Control Points’ from straight to curved. Once a section 
is a curve, this option will change to ‘Make Straight Section’ to allow you to make it straight again. 

 

 



Page 12 
 

 

 

Curve All: This changes all of the land plot edges to curves. Once they are curves, this option will change to 
‘Straighten All’ to allow you to make the sections straight again. 

 

 

 

Add Control Point: With a section highlighted by the cursor, this function allows you to add a control point at the 
location of the cursor. 
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Double Control Points: This adds additional control points between each existing control point. It is handy when you 
want to make a more detailed land plot shape, but don’t want to manually add control points. 

 

The ‘SURFACE LAYER’ View Menu 

Right-clicking on the land plot and choosing the ‘View’ menu gives you a couple of options. 

 

Zoom To: If you have an object or terrain shape selected, the ‘Zoom To’ function will automatically change the screen 
view to focus on that item. If you have nothing selected, ‘Zoom To’ will return you to the overall land plot view. 

Unhide All: If you have chosen to hide an element of your course design, this function will make them visible again. 
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CPG2 COURSE ARCHITECT TUTORIAL 

CREATING A BASIC GOLF HOLE by Dave Craven 

Here we’ll look at one way of creating a very basic golf hole layout in the Course Editor. Each designer will find their 
own personal way of creating a hole to their satisfaction as their talent progresses, but for the beginner this is a simple 
walkthrough to get you started in what may well be your career in Golf Course Design. 

First you need to know that to zoom in and out you use the up and down arrow on the keyboard and to move side to 
side you use the left and right arrow keys. To scroll up and down you use the Q and A keys. For faster zooming and 
scrolling press and hold the left SHIFT key followed by the action key of your choice. 

 

Zoom in towards the land plot. Hold down the spacebar and draw 3 sides of a box with the mouse and then let go of 
the spacebar. 

 

 

In the menu that pops up choose ‘Closed Shape’. 
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Right click one of the edges of the shape then select ‘EDIT’ and then ‘STRAIGHTEN ALL’. 

 

 

 

Select each corner ‘point’ in turn and manipulate the new box into an oblong then select the Tape Measure tool. 
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Check the length and breadth of the tee box is either realistic or set to the measurements you want. 

 

 

 

For the fairway, set the Tape Measure to about 420yds. Draw another open ended shape and close it in the same 
manner as with the tee box above. 
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Scroll to the fairways end and draw another unfinished shape, select ‘Closed Shape’ and we have a basic green. Use 
the Tape Measure to help you size it if you wish. 

 

 

 

Click on individual ‘Control Points’ on the green shape to manipulate the shape until you like it. If you accidentally 
move the green use the UNDO option in the EDIT menu to snap it back into place. 
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Zoom back out and you can see you have now laid out a basic hole with a tee, fairway and green. 

 

 

 

Zoom back to the tee box and right click it centrally to highlight the whole shape and bring up the mouse menu. Select 
EDIT and then EDIT TEMPLATE. 

 



Page 19 
 

 

In the TEMPLATE window select CREATE NEW TEMPLATE. 

 

 

 

Make sure the ‘Tee’ and ‘Playable’ boxes are ticked then select CHANGE TEXTURE. 
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In the window that opens select the SURFACES folder. 

 

 

 

In the window that opens select the TEE folder. 
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For this basic hole we will select TEE 10.jpg then select OK. There are 4 known file types that the designer supports 
for textures and they are (.jpg, tga, bmp, tiff). 

 

 

 

Make sure that the ‘Tee’ and ‘Playable’ boxes are still ticked and select ‘SAVE AS’. 
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For this test version we will call this template Tee Test 1 and click on SAVE then OK. 

 

 

 

Now the tee has a texture assigned to it and a dedicated template. (Hint: Assign the already created tee template to all 
the tees on the course as you make them and then all tees on the course will have all the same characteristics). 
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Now right click on the tee, (to highlight the whole tee, not just an edge), then select EDIT and ASSIGN TEE TO HOLE. 

 

 

 

Assign the tee to hole 1 and select OK. A number 1 will appear on the tee. 
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Zoom back out, right click on the fairway and select EDIT then EDIT TEMPLATE. 

 

 

 

In the TEMPLATE window select CREATE NEW TEMPLATE. 
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Make sure the ‘Fairway’ and ‘Playable’ boxes are ticked then select CHANGE TEXTURE. 

 

 

 

Select SCENERY then the FAIRWAY folder. 
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Select FAIRWAY 10.jpg and then OK. (HINT: the textures supplied with the game are numbered in such a way that 
Fairway 10, Tee 10 and Green 10 etc should complement one another). 

 

 

 

Name the template ‘TEST FAIRWAY 1’. 
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Now create a green template on your own using similar steps as above for the green and fairway. (NOTE: In this 
example below I have templates already saved from making a previous course so instead of making a new template 
for the green I have simply double clicked the fairway template of another course and then saved it to apply it to my 

green on this new hole/course). 

 

 

Right click the green and select ADD BORDER. 
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Right click the Border and select EDIT TEMPLATE. 

 

 

 

As above, make a new template for the green fringe. (NOTE: In this example I have chosen to use a previously made 
Fringe template). 



Page 29 
 

 

 

Right click the fairway and select EDIT then ADD BORDER. 

 

 

 

Right click the border and create a template. (NOTE: In this example I have chosen to use a previously made fairway 
1st cut template). 
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Right click the fairway 1st cut and select CHANGE BORDER WIDTH. 

 

 

 

The standard border width is 2 and that is usually good enough but for this example make it 4 and select OK. 
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Right click the green and select EDIT then ASSIGN GREEN TO HOLE. 

 

 

 

 

Check HOLE 1 and select OK. 
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Now you can see that with both the tee and green assigned, a line appears running between them both and the ‘1’ 
denoting the hole number has moved off the tee and is now central to the hole. 

 

 

 

Right click on the hole and select EDIT then ADD SHOT TARGET. 
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The Shot Target will be the point the golfer aims at while on the tee. Only one shot target per hole is required. The 
Shot Target can be repositioned at any time. (It cannot be seen in the Game itself). 

 

 

 

Scroll over to the tee, right click it and select EDIT then COPY. 
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Right click in front of the tee and select EDIT then PASTE. 

 

 

 

Left click and drag the new tee box and place it where you wish then click on each tee in turn and EDIT then ASSIGN 
TEE NUMBER. (The longest tee on the hole should always be number one, the shortest number 5). So in the example 
below you now have a ‘1’ tee and a ‘2’ tee. This is the fastest way to duplicate tees especially if you wish them to line 

up together as opposed to having them spread out. 
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Scroll to the green, right click it and select ADD then ADD PIN. 

 

 

Scroll in to the pin and right click and select EDIT then FLAG. (NOTE: In the above picture I have rotated the land plot. 
There are two ways to do this. Either hold down the mouse scroll wheel button and move the mouse, though the best 

way is probably to just hold down the ‘M’ on the keyboard and move the mouse). 
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Now select the colour, size, (and number if desired and if applying flags individually), and if picking a plain or custom 
flag, apply the change to all flags, (CHANGE ALL), on the course, if required. However, applying the flag to all on the 

course is best left until all the designated pins are on all of the greens, (3 per green). 

 

 

 

Right click near the green and select ADD then SET TEST START POSITION. 
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A ‘SAVE’, from the File Menu, is recommended before entering the playable part of the Editor, then Select TEST and 
you will be placed at the test Start Position in the playable 3D version of the Editor where you can walk around the 

course using the W, S, A and D keys plus the mouse, (for looking around). 

 

 

 

Press ESC to exit back to the Surface Editor and in the File Menu select SAVE 

 



Page 38 
 

 

Before playing let’s make the back tee a bit more difficult to play. Left click and drag it off to the side, making the 
approach to the fairway more difficult. 

 

 

Now the tee doesn’t line up with the fairway properly so right click on it, select EDIT then ROTATE. 
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Now move the slider to rotate the tee to face the Shot Target, which you placed on the fairway earlier, and select OK. 
In the last step I will show you how to add a blend to your textures. Blending makes 2 textures look more seamless in 
transition of each other.  

 

Highlight your texture you would like to add a blend to, right click and select Edit/Add Blend. You will now see your 
texture with the default blending mask surrounding it.  
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Now right click and select Edit/Change Blend Mask. 

 

I used Mask 05.TGA here, there are available masks in the Surface/Masks folder but you can also make your own 
using a greyscale image as shown in the picture above in the preview section on the box. 
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Right click on the blended shape and select Edit/Change Blend Width. In this instance I used a slider setting of 3.02 
which would be a 3 yard blend. (Above Picture). 

 

Go to the MENU bar select FILE then SAVE. You now have a completed basic saved hole! Return to the FILE menu 
and select PLAY. 
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Congratulations! Here you are standing on the first tee of the first hole you have just made. 

 

Helpful hints for designing a hole – A recap 

Shapes on the land plot can be manipulated either by moving or dragging with the mouse or can be reshaped by 
moving the individual ‘Control Points’ on the shape. Advanced tip: If a shape requires more ‘Control Points’ for say 
intricate shaping of bunkers, right click on the shapes edge between two ‘Control Points’, select EDIT  and then either 
add more a control point or select  DOUBLE CONTROL POINTS to literally double the amount of ‘Control Points’ that 
the shape already has. 

Templates have to be applied to every shape you put on the course, (tee box, fairway, first cut, green, green fringe, 
rough, bunkers, bunker lips, paths etc). They hold the data for the textures used on the shape, (including the texture 
qualities like bounce, roll, spin, colour etc). So the first time you make a green you make a template for it by right 
click/edit/edit template and selecting create new template, sort out the texture required and then save it, (as say, 
e.g. 'Green 1'). When you make your second, third, fourth, etc, green, you apply/use the same template to it so that 
all the greens on the course have the same texture and qualities. The beauty of this is that if you wish to change a 
greens texture or qualities you just alter the template and all the greens on the course get the new data. If you want 
to change the sand texture in the bunkers, change the Bunker template you made and voila, all 300 bunkers on the 
course have the new sand in them, (assuming all bunkers do have the same sand and therefore the same template, 
of course). Having laid out the whole course you decide you don't like the fringe you used for the greens. Change the 
template texture or colour and save it and instantly all the green fringes take on the new colour/texture. 

All holes need tees and greens assigning to them. One of the reasons is that if a hole has a massive shared green, 
three of the pins will belong to one hole while 3 others will belong to another! Or you could make a 9 hole course 
with 2 sets of tees for each green. One set being 1 – 9 the other set being 10 – 18! A hole isn’t playable until tees and 
greens are assigned. 
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Make regular saves of your work especially after doing time consuming detailed work. A finished course could have 
hundreds of save files. If you constantly save over the same file name then make a mistake or have a system crash, 
you can’t go back to the previous save as you will have overwritten it. One suggestion is to start the first save as ‘My 
Course 001’ and then the second save can be ‘My Course 002’. If you make a significant save you could name it ‘My 
Course 025 testing a new lake.’ 

Backup your course files! A computer failure could see all your work lost. Make a backup of at least your most recent 
save file on a different or backup hard drive. It is just awful losing 100’s of hours work for the sake of an extra save 
taking a few seconds. 
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CPG2 COURSE ARCHITECT TUTORIAL 

Height Layer tutorial by Joe Habiger 

Here you will find some tips for understanding the basics and getting started in creating great 3D golf courses. This 
tutorial will not show every aspect of the Editor as there are sometimes alternative ways to do things but 

understanding the basics is essential to making good courses. 

The ‘HEIGHT LAYER’ Menu 

 

Height Layer: Allows you to edit the terrain in a 3D environment such as shaping hills, bunkers, slopes, lakes etc. 
You can also place objects via the (F2) hotkey, this will bring up a box where you can browse to the objects you want 
to use, you can also set there size and if you want random size and rotation checked. The (F3) hotkey will bring up a 

window of objects in use and which key to press to place the object. 

There are (2) main menu items within the height layer and each will open another submenu; I will give you a brief 
detailed description of each item here. 

 

 

Add Water: Will add water on a single plane so if for instance you have a ditch or depression where you would like 
water, right click in the middle of the depression and click Add Water and a semi - round sphere will show up. Right 

click on the semi – round shape and a box will pop up allowing you to set the water height, update water shapes and 
colours of the water. 
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Add Water From Shape: Same as the above Add Water but in this case it will make a water shape in the shape of 
the depression you used, care must be given when using this because if you raise the water to much the ball can 
actually go under the water. Always make a HAZARD texture in the surface layer to place in your lake depression 

otherwise if the ball does go under the water the ball may stay in play but actually be unplayable! 

 

Add Object: To add an object right click where you would like to place it and select Add Object and then select from 
2D or 3D objects to add to the course, you can right click on the object afterwards and select EDIT to edit the height of 

the object, flatten around object. You can also rotate, resize, duplicate or delete this object you have just placed. 

 

Add 2D Object: You have the option of also placing 2D objects as the main objects but being a 3D environment the 
objects will rotate with certain camera’s use, but not the stationary or snap cam. 

 

Add Particle System: You have the option to add particle effects using .xml files located in your resources folder, if 
you do not have a folder named Particle Systems add one and place all your particle effects in there. These effects 

are really nice to have; smoke billowing from a small volcano is really neat. 

 

Add Camera: Adding a stationary camera and using the Hotkey ‘C’ you will see a full screen view of your elevations 
and surrounding area’s as you would see in the test mode. You can walk around just like in test mode using the ‘A, W, 

D and S’ keys. Hitting the Hotkey ‘C’ again returns you to where you started. 
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Get Shape: Using the get shape tool you can select shapes in the height layer and when clicked they will 
automatically surround your selected shape with a RED Shape for use with elevations. (Elevations will be covered in 

another tutorial, but here is a tip when using the Get Shape tool, it’s always good to have enough control points in your 
shape when building this shape in the surface layer because if you don’t have enough control points the square shape 

you made can turn into an oval shape when clicked on. Also having enough control points helps with elevations as 
well because it allows for finer detail when raising or dropping land.) 

 

Flatten (Entire Plot): One word when using this tool is CAREFUL! As the name suggests it will flatten your plot 
entirely so care must be given that you know you want to. Use this tool on a course that is not saved/backed up and 

all elevation work will be lost! 

 

Randomize (Entire Plot): This is a spectacular tool that allows you to use iteration sliders to set randomization of the 
entire plot. The possibilities of random elevations are pretty much endless. 

 

Smooth (Entire Plot): Using this tool and the iteration sliders it gives you on can go from little loss of elevations to a 
lot at one time. The lower the number on both sliders the less it will smooth, the higher the number on both sliders the 
more it will smooth. My advice is to start small, you can always bump the sliders up more (higher number) if needed. 

 

Simplify (Entire Plot): This tool simplifies the mesh system and elevations most likely will be affected so my advice is 
to us this tool in area’s you won’t be hitting balls. This tool will take detail away from the mesh using iteration sliders; 

setting it to high will pretty much wipe out all elevations so be careful. 

HEIGHT LAYER EXAMPLES 

SLOPES by Dave Craven 

For any new designers out there, here is a very quick way to make slopes on your course. Select your high 'area', 
(marked red), by holding down the spacebar and drawing the shape with the mouse. Then repeat the process and 

mark out your yellow area, the low point. See pic 1. 
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Select the bottom right icon in the Fall Off box at the bottom right of the screen, Then you can roll the mouse wheel 
forward or grab the marker in the centre of the elevation bar running up the right of the screen and lift your land. 

 
I have exaggerated it for this purpose but you can see the red area rises up and the land falls away to the edge of the 

yellow area. You can then increase the size of the yellow area a little bit, (by redrawing it or by right clicking and 
‘SCALING’ it), and smooth the area to help regain a smooth natural look to the elevation. (Never smooth inside a red 

area without a yellow buffer outside it or the ‘smooth’ will spread across the course). 
 

Remember, one of the key elements to making a good golf course is to make the elevations look realistic, and look 
like Mother Nature made them. Nature rarely makes perfect circles. Make your shapes random. 
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BUNKERS by B.J. Weworski 

Here is an quick, easy way to make a basic bunker. 
 

 

Right click, edit, get shape and left click on a bunker which will auto-create a primary red shape exactly around your 
bunker edge. 

 

Hit the B key and drag slider all the way left to 1.0 (3 feet). 

 

Scroll your mouse wheel towards you about 5 to 7 times to lower the inner sand shape. 
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Now either rescale your yellow falloff shape or draw a shape approximately 10 foot around your current falloff shape 
(enough to allow for smoothing range from the old falloff edge) and click on Falloff/yellow when window pops up. 

 

 

Right click within your primary red shape and choose "Smooth Inside Red" which will actually allow the smooth 
operation to affect the area within both shapes. **Use a falloff shape whenever you're smoothing to keep the effect 

concentrated within the boundaries of your shape selections only. 

Set the first smooth pass to filter:1, iterations:5 
2nd smooth pass to filter:40, iterations:5 

Finally do a couple more smoothes back at filter:1, iterations:5 

This may sound like a bunch of steps but it actually goes very quickly once you get used to the steps. Note that the 
editor will receive an optimization update eventually to fix the delay that you will get now on a course with a full layout 
and general elevations in place when doing elevation changes to a new shape selection. Also, I have found that going 

from low to medium to low, etc with your filter value seems to get the job done quicker and cleaner. 

 

HINTS: The unit slider still has increments in yards/meters per whole value (1.0 slider value = 1 yard).  
 

A hidden option that is extremely handy to use is the "B" key in the height layer. Draw your red primary shape and 
then hit the “B” key and it will bring up the window that lets you select the scaled size of the yellow falloff shape. This 

will then auto-create the falloff shape for you based on the value you choose. 
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CPG2 COURSE ARCHITECT TUTORIAL 

Object Placement Tutorial by Brian Silvernail 

While objects can be added to a course on a flat land plot it is not recommended as when elevations are added to the 
plot it will disrupt the object lying on it. The object could then be skewed out of true or left balancing on a ridge. Here 
we look at the structure of the menu that allows you to add objects to your newly created course. 

The ‘Add Object’ Menu 

 

To place an object, right click, select ADD then OBJECT 

 

Add Object: This brings up a file menu where you can then select the type of 3D object file you would like to add to 
your course. The 3D object types are sorted by different directories. 



Page 51 
 

 

In this example, I’ve selected a clubhouse object to place from the ‘BUILDINGS’ folder. Clicking Ok will place the 
object on the land plot. If you are currently viewing the entire land plot, you may need to zoom in (up arrow on 
keyboard) to see the object you just placed. To move the object, click and hold on your object while you move the 
mouse to reposition the object. 

The ‘Edit’ 3D Object Menu 

If you would like to edit the properties of your 3D object, click on it and right-click to bring up the ‘Edit’ menu. 

 

Edit Height: Brings up a slider bar that allows you to change how far your object is below or above the surface of the 
terrain. If the terrain is not flat you may well need to sink the object into the floor slightly to stop one edge hovering 
above the ground. This is especially true of trees on the course that are on slopes! Hint: If you have a tree you want to 
duplicate, plant it and then sink it into the ground some. Then when you do copy and plant the next tree, that tree is 
already sunk into the ground too as it copies the original. 
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Rotate: Brings up three slider bars that allow you to change the rotation of your object. The first is ‘Rotate About X 
Axis’. Looking at the object from the top view, the X Axis pitches the object forward and backward. The second slider 
is ‘Rotate About Y Axis’. This rotates the object clockwise and counter-clockwise. The third slider is ‘Rotate About Z 
Axis’. This pitches the object from left to right. The rotate function is very powerful and comes in handy when aligning 
3D object to various height terrains, such as making a bridge object connect two different banks.  

 

Scale: Brings up four slider bars that change the height settings for your object. If you want to change the overall size 
of your object, it is best to use the ‘Scale All’ slider at the bottom. This keeps the object in proportion as it is resized. If 
you want to adjust the scale of individual object height properties, you can do that with the three top sliders, ‘Scale 
Height’, ‘Scale Width’, and ‘Scale Length’. 

Duplicate: Creates an exact copy of the object you have selected. 

Replace All of Type: Allows you to replace all of the objects on your course that are the same as the one you have 
selected with a different object file. You can choose the new replacement object from the file menu. 
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Create a Moving Path: Allows you to animate your object. To create a movement path, hold down the Spacebar and 
draw a line with your mouse. Once done, CPG2 with close the path and the object will move along the path during test 
mode and gameplay. Once you have a path created, if you return to the object ‘Edit’ menu, it has a new menu option, 
‘Set Speed’ that allows you to select how fast the object moves along that path. 

 

The ‘Add 2D Object’ Menu 

 

To access the ‘Add’ menu, right-click on the main course land plot. 

Add 2D Object: Brings up a file menu where you can then select the type of 2D object file you would like to add to 
your course. CPG2 does not ship with a large choice of 2D objects, so this will probably be most useful if you are 
importing custom artwork. Targa files (TGA) are the best format to use since you can utilize alpha channels to create 
transparent areas around your object. 
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The ‘Edit’ 2D Object Menu 

If you would like to edit the properties of your 3D object, click on it and right-click to bring up the ‘Edit’ menu. 

 

Change Texture: Brings up the file menu where you can choose a new image for your object. 

 

Dimensions: Brings up two slider bars that allow you to adjust the height and width of your object. 

Mirror: Flips your 2D object horizontally. 

Edit Height: Brings up a slider bar that allows you to change how far your object is below or above the surface of the 
terrain. 

Duplicate: Creates an exact copy of the object you have selected. 

Replace All of Type: Allows you to replace all of the objects on your course that are the same as the one you 
currently have selected, with a different object file. 
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CPG2 COURSE ARCHITECT TUTORIAL 

Flyby Camera Tutorial by Joe Habiger 

The flyby camera system allows you to either check out each hole and/or pin locations before you play that hole or 
you can use it to show off your whole course in videos or at the start of each offline round. I will get into the course 
flyby camera at the end of this tutorial so let’s start off with the hole overhead flyby system camera. 

 

In this example I will use the 12th hole at Augusta National, first off we need to hold down the space bar and draw a 
line from tee to green. Once that is accomplished let go of the space bar and a box will appear. 

 

Select Camera/Flyby and you should end up with a spline with some control points on it. (Below Picture) 
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You’ll noticed the 3 colors on the control points when you click on them, blue and green will move the spline around on 
one axis and the red will raise of lower the control point. The flyby camera runs along the spline so if it is raised the 
view from the camera will be higher and theoretically you should be able to see more of the course or hole below it. 

 

 

 

In this picture I have raised the control point higher and pulled it back about 20 yards in back of the tee to allow the 
camera to come INTO the tee instead of starting out right on top if it. This way they see the whole hole and not just 
part of it. 
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I’ll put this here but usually when I first draw the shape using the space bar to make the camera spline I will assign a 
hole to it so it knows which hole I am creating the camera path on. Be careful and make sure you know what hole your 
working on because if you select hole #13 and you click flyby on hole #13 the hole you actually are going to see is 
hole #12 (The one were working on now). 

 

 

 

 

Were now going right click on a spline or control point and select Edit/Flyby Speed. 
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I like to keep my camera speed at 25 because it is just the right speed I think to give the players and opportunity to 
see the hole and also get a view for the pin location. To fast a speed and the players don’t get a chance to see much, 
but then again you don’t want to be to low or the players will get bored waiting for the camera to get to the green. 

 

 

 

 

 

Right click once again on the spline or control point and select Edit/Flyby Camera Type. 
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In this box we have 3 choices to select, the first one is Orientation Follows Spline. This one is just a basic camera 
type; the camera will follow the spline with no rotation of the camera and no fixed target. This one is best to just draw 
your shape from tee to green.  

 

Fixed Target follows the spline as well but you also have a fixed target so the camera will rotate depending on where 
the target and spline is. To add a fixed target highlight a control point or the spline again and select Edit/Flyby 
Camera Type, then select Fixed Target. Now to actually place a fixed target right click once more on a spline or 
control point and select Edit/Edit Camera. You’ll see a small ball appear near the hole and just like the control points 
it is color coded to allow for moving or raising and lowering, notice the box that says Press Escape to Cancel don’t 
worry about that, it just basically gets rid of the ball from view and the ball will always stay there until you select 
another camera type. What I like to do is place the round colored ball right in the middle of the green this way I can 
move my spline to the side of the green and circle back towards the front of the green and the camera will focus on 
the invisible ball. 
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The User Defined flyby camera type is pretty much more customization of the camera system but I am not really sure 
how it works yet, best place to get info on this type of camera flyby system is through the forums at this website. 

CustomPlayLive.com A Golf 2 Community 

 

 

 

We now have the opportunity to have a flyby camera for the whole course but the only draw back is it only works when 
you’re playing by yourself and not an online game. To set it up just use the same spacebar/draw line fun as you had in 
the single hole part above. Instead of selecting a hole to assign click on the Assign to Course instead. There are 
many ways of drawing the line out for the course flyby from drawing a circle around the perimeter of the course to 
drawing a line through every hole. Once you get this done then save the next time you open the course the course 
flyby should work as soon as the course loads. To exit the flyby system just click the mouse or hit a key on the 
keyboard. 

 

 

 

 

Logos can be added to course flybys and screenshots, (as mentioned on page 2 – The EDIT Menu) by pressing the 
F8 key. To add a logo click on the Edit button and select Logo at the top of the menu. 
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What I did was add a folder called Logo’s in windows explorer since there is no folder like this and it makes it much 
easier to find as well. Browse to the file after you double click on the Logo’s folder to open it and hit OK. Alternatively if 
your custom course flag is a .jpg file that could be used.  NOTE: All logo’s need to be in .jpg format and won’t have an 

alpha channel. I hope to see this changed some day in an update to include .TGA support so we can add alpha 
channels and keep the logo looking cleaner. 

 

 

 

As you can see the logo will now show when I take screenshots and course flyby’s and hole flyby’s and will show on 
screenshots if you press the F8 key first. 


